BAB I
PENDAHULUAN

A. LATAR BELAKANG

PT Telekomunikasi Indonesia merupakan perusahaan informasi dan
komunikasi juga penyedia jasa dan jaringan telekomunikasi. Salah satu produk
unggulannya adalah IndiHome Fiber , layanan digital yang menggunakan teknologi
fiber optik yang menawarkan layanan Triple Play 100% fiber yang terdiri dari Internet
Fiber atau High Speed Internet (Internet Cepat), Interactive TV (UseeTV) dan Phone
(Telepon Rumah). Selain itu ada juga layanan Dual Play yaitu Internet Fiber ( Internet
Cepat ) dan Fixed Phone (Telepon Rumah ) atau Internet Fiber (Internet cepat) dan
UseeTV (TV Interaktif) [1].

Seiring teknologi dan komunikasi yang berkembang sangat pesat Telkom
berupaya menemukan solusi atau suatu sistem yang lebih efektif dan efisien. NOSS-F
(New Operating Support System Fullfillment) merupakan aplikasi operating support
system yang berorientasi peningkatan layanan kepada pelanggan. NOSS-F digunakan
untuk antara lain melakukan Data Management (pelurusan data), Penanganan Migrasi
Tembaga ke Optik dan Pemasangan Baru Layanan Telkom. Dengan adanya
pelaksanaan Kerja Praktik kali ini adalah ikut serta berperan dalam program yang
dilakukan oleh PT Telkom Yogyakarta di Kantor Telkom Pugeran guna menciptakan
layanan yang lebih efektif juga efisien [1].

Oracle Communications Unified Inventory Management (UIM) adalah solusi
manajemen inventori yang digunakan untuk mengelola dan mengoptimalkan inventori
perangkat dan jaringan telekomunikasi. UIM digunakan untuk mengumpulkan,
menganalisis, dan menyediakan informasi inventori perangkat yang digunakan oleh
operator telekomunikasi untuk mengoptimalkan operasi jaringan dan mengurangi
biaya.

Tidak ada informasi yang tersedia tentang permasalahan spesifik pada Oracle
Communications Unified Inventory Management, karena informasi ini mungkin
bersifat korporat dan bersifat rahasia. Namun, beberapa masalah umum vyang

mungkin terjadi pada sistem manajemen inventori termasuk: kesalahan data, integrasi



yang tidak lancar dengan sistem lain, masalah keamanan, dan kinerja yang lambat.
Rekomendasi terbaik adalah berkonsultasi dengan vendor atau teknisi produk untuk
memahami dan memecahkan masalah yang spesifik.

Input data RFS (Ready for Service) validation merupakan proses validasi yang
dilakukan untuk memastikan bahwa perangkat jaringan yang baru ditambahkan ke
dalam sistem telah sesuai dengan spesifikasi yang ditentukan dan dapat digunakan
dengan baik. Proses ini dilakukan sebelum perangkat diaktifkan dan digunakan dalam
jaringan.

Beberapa masalah yang mungkin terjadi pada input data RFS seperti,
kesalahan data: sehingga menyebabkan masalah pada proses pengolahan data,
format data yang tidak sesuai: data yang dimasukkan harus memenuhi format yang
ditentukan agar dapat diproses dengan benar, kelebihan atau kekurangan data: input
data yang terlalu sedikit atau terlalu banyak dapat menyebabkan masalah pada proses
pengolahan. Untuk mengatasi masalah-masalah tersebut, disarankan untuk
melakukan validasi data secara berkala, memastikan format data sesuai dengan yang
ditentukan, dan memastikan integrasi dengan sistem lain berfungsi dengan baik.

Berikut nya menggunakan Oracle UIM, operator dapat mengimpor data RFS
dari perangkat jaringan yang baru ditambahkan ke dalam sistem dan menvalidasinya
dengan mudah. UIM memungkinkan operator untuk mengecek konsistensi data,
memvalidasi konfigurasi perangkat, dan memverifikasi bahwa perangkat telah diuji
dan divalidasi sebelum digunakan dalam jaringan. Ini memungkinkan operator untuk
memastikan bahwa perangkat baru yang ditambahkan ke jaringan dapat beroperasi

dengan baik dan tidak akan menyebabkan masalah jaringan.

. IDENTIFIKASI MASALAH

Ada beberapa identifikasi masalah yang dapat muncul dalam proses validasi

RFS menggunakan UIM:
1. Kesalahan data: UIM dapat menemukan kesalahan data dalam proses import data
RFS dari perangkat jaringan. Ini dapat disebabkan oleh kesalahan manual (teknisi)
dalam memasukkan data atau kesalahan dalam sistem eksternal yang digunakan

untuk mengumpulkan data.



2.

Uji coba tidak lengkap: UIM dapat menemukan bahwa perangkat belum diuji dan

divalidasi sebelum digunakan dalam jaringan. Hal ini dapat menyebabkan masalah

jaringan saat perangkat diaktifkan.

. BATASAN MASALAH

Ada beberapa batasan masalah dalam proses validasi RFS menggunakan UIM

yang perlu diperhatikan:

1.

Data yang diterima: UIM hanya dapat menvalidasi data yang diterima dari
perangkat jaringan. Jika data yang diterima tidak akurat atau tidak lengkap, maka
proses validasi tidak akan efektif.

Kemampuan uji coba: UIM hanya dapat menvalidasi perangkat yang telah diuji dan
divalidasi. Jika perangkat tidak diuji atau diuji dengan tidak cukup, maka proses

validasi tidak akan efektif.

. RUMUSAN MASALAH

Rumusan masalah dalam proses validasi RFS menggunakan UIM adalah

sebagai berikut:

1.

2.

Bagaimana mengetahui proses input data RFS yang dilakukan menggunakan UIM
mengalami kesulitan dalam menjamin keakuratan dan kelengkapan data RFS yang
diinput?

Bagaimana mengetahui persoalan masalah dalam proses validasi?

. TUJUAN PRAKTIK MAGANG

Tujuan dari input data RFS validasi valins menggunakan Oracle UIM adalah

sebagai berikut:

1.

Memudahkan proses untuk memastikan bahwa data RFS yang diinput ke dalam
sistem UIM akurat dan lengkap, sehingga dapat digunakan untuk proses validasi
RFS yang efektif. Tujuan ini akan memastikan bahwa perangkat jaringan yang baru
ditambahkan ke dalam sistem telah sesuai dengan spesifikasi yang ditentukan dan
dapat digunakan dengan baik dalam jaringan.

Mengetahui proses untuk memastikan bahwa data RFS yang diinput telah diuji dan
divalidasi sebelum digunakan dalam jaringan, sehingga memastikan bahwa

perangkat dapat bekerja dengan baik dan dapat diandalkan.

MANFAAT PRAKTIK MAGANG

1.

Bagi Penulis:



a. Sebagai pengalaman dalam mengaplikasikan berbagai ilmu pengetahuan yang
di peroleh selama kuliah.
b. Sebagai pengalaman di dalam dunia kerja.
c. Sebagai bahan rujukan bagi Fakultas Teknologi Industri khususnya prodi
Informatika, Universitas Ahmad Dahlan.
2. Bagi Pengguna:
a. Membantu pihak Telkom Akses Yogyakarta dalam melakukan kegiatan Input

Data RFS Validasi Valins Menggunakan UIM.



BAB I
GAMBARAN INSTANSI

A. UMUM
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Gambar 2. 1 Logo Telkom Akses

PT. Telkom Access merupakan anak perusahaan dari PT. Telekomunikasi
Indonesia, Tbk bergerak dalam bidang pembangunan dan pengelolaan layanan
infrastruktur jaringan. Dapat dilihat pada gambar 2. 1 merupakan logo dari Telkom
Akses by Telkom Indonesia [2]. PT. Telkom Akses didirikan pada tanggal 12 Desember
2012 dan sejak saat itu aktif dalam industri konstruksi penyediaan jaringan akses
broadband, antara lain sebagai Lessor Network Terminal Equipment (NTE) dan sebagai
perusahaan yang mengelola service operation and maintenance (OM ). , operasi dan

pemeliharaan layanan jaringan akses broadband.

PT Telkom Access berupaya menyediakan akses Internet yang berkualitas
dan terjangkau untuk meningkatkan kualitas sumber daya manusia agar mampu
bersaing dalam skala global. Saat ini, PT Telkom Akses sedang membangun jaringan
inti berbasis fiber optic dan Internet Protocol (IP) dengan menggunakan 30 terra router
dan sekitar 75.000 kilometer kabel fiber optic. Pembangunan kabel fiber optic tersebut
merupakan bagian dari program Digital Network Terminal Equipment (NTE) Indonesia

dan layanan pengelolaan dan pemeliharaan operasi jaringan broadband.

Adapun visi, misi, dan tujuan perusahaan pada PT. Telkom Akses, Tbk sebagai

berikut :



1. Visi

Menjadi perusahaan jasa operasi dan pemeliharaan jaringan broadband dan jasa

konstruksi infrastruktur telekomunikasi yang terdepan di kawasan nusantara yang

berorientasi kepada kualitas prima dan kepuasan seluruh stakeholder.
2. Misi

a. Mendukung suksesnya pengembangan perluasan dan peningkatan kualitas
infrastruktur jaringan akses PT. Telekomunikasi Tbk.

b. Memberikan layanan prima dengan orientasi tepat mutu, tepat waktu, dan
tepat volume infrastruktur jaringan akses.

c. Menciptakan tenaga kerja yang profesional, handal, dan cakap dibidang
teknologi jaringan akses dan membina hubungan baik dengan lingkungan
terkait pekerjaan konstruksi.

d. Memberikan hasil terbaik bagi seluruh stakeholder.

3. Tujuan Perusahaan

a. PT. Telkom Akses menjamin kepuasan setiap pelanggan, baik itu institusi
maupun pelanggan akhir serta kepuasan stakeholder melalui komitmen
seluruh jajaran Telkon Akses dalam menerapkan Sistem Manajemen Mutu.

b. PT. Telkom Akses memiliki komitmen memberikan layanan terbaik melalui
pengelolaan ekselen jasa konstruksi dan manage service sesuai persyaratan
Sistem Manajemen Mutu yang ditetapkan yang berorientasi kepada tepat
mutu, tepat waktu, dan tepat volume.

c. PT. Telkom Akses berkomitmen meningkatkan mutu dan kinerja dalam rangka
memenuhi persyaratan, meningkatkan kepuasan pelanggan, dan stakeholder
serta mendorong pencapaian tujuan perusahaan baik jangka pendek maupun
jangka panjang.

d. PT.Telkom Akses akan meninjau kesesuaian Kebijakan dan Sistem Manajemen
Mutu secara berkala sesuai dengan perkembangan perusahaan.

B. STRUKTUR ORGANISASI DI TEMPAT MAGANG
Struktur organisasi ditetapkan bagaimana cara tugas dan pekerjaan dapat
dibagi, dapat dikelompokkan dan dapat terkoordinir secara formal. Dari pernyataan

tersebut. Struktur organisasi disebut sebagai suatu sistem atau jaringan kerja pada



tugas, sistem pelaporan dan komunikasi yang mampu menghubungkan secara
individual dengan kelompok.
Gambar 2.2 adalah struktur organisasi yang dimiliki Unit Access Data

Management Telkom Akses Yogyakarta.
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Gambar 2. 2 Stuktur Organisasi Telkom Akses YK

C. SUMBER DAYA MANUSIA DAN SUMBER DAYA FISIK DI LOKASI MAGANG
Sumber daya manusia dan sumber daya fisik adalah faktor yang tidak dapat
dipisahkan dan sangat erat kaitannya dengan kualitas tenaga kerja.
1. Sumber Daya Manusia
Tabel 2.1 adalah sumber daya manusia pada pada Unit Access Data
Management Telkom Akses Yogyakarta yang dimiliki berjumlah 25 orang, yang
terdiri dari 12 anggota HD DAMAN MITRA-KOPEGTEL, 7 anggota SURVEY DATA
DAN INVENTORY ANPRUS-TELKOM AKSES, dan 6 anggota IOAN VALDAT ANPRUS-
TELKOM AKSES.

Tabel 2. 1 Sumber Daya Manusia

No. Jabatan/Bidang/Pegawai Jumlah
1. HD DAMAN MITRA-KOPEGTEL. 12
2. SURVEY DATA DAN INVENTORY ANPRUS-TELKOM 7

AKSES.
3. IOAN VALDAT ANPRUS-TELKOM AKSES. 6




2. Sumber Daya Fisik
Tabel 2.2 adalah sumber daya fisik pada pada Unit Access Data

Management Telkom Akses Yogyakarta.

Tabel 2. 2 Sumber Daya Fisik

No. Sumber Daya Fisik Jumlah
1. PC/Komputer 13
WiFi 2

D. PROSES BISNIS SAAT INI YANG BERHUBUNGAN DENGAN TEMA PRAKTIK MAGANG

Proses bisnis adalah suatu kumpulan aktivitas atau pekerjaan terstruktur yang
saling terkait untuk menyelesaikan suatu masalah tertentu atau yang menghasilkan
produk atau layanan.

Gambar 2. 3 merupakan proses bisnis mirroring, yang dimana nanti nya admin
merekap perdata (per ODC), selanjutnya admin akan melakukan mirroring ke sheet
dengan memasukan rumus yang sudah tersedia, lalu sistem mirroring melakukan
proses nya perdata, lalu sistem mirroring melakukan proses decision atau keputusan
sebelum melanjutkan pada proses berikutnya jika tidak maka melakukan pengulangan
untuk merekap perdata ke sheet apakah sudah benar atau belum namun jika iya maka
mirroring ke sheet berhasil, dan selesai untuk perdata yang pertama nanti dilakukan

berulang untuk keseluruhan data mirroring.

ADMIN SISTEM MIRRORING

merekap perdata ke log sheet
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YA /—\TIDAK
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Gambar 2. 3 Proses Bisnis Mirroring



Gambar 2. 4 merupakan proses bisnis RFS validasi valins, yang dimana nanti
nya admin melakukan proses login lalu sistem menampilkan menu, selanjutnya admin
melakukan pilihan menu yaitu ada menu data validasu valins dan menu search data
validasi valins, lalu sistem melakukan proses decision atau keputusan sebelum
melanjutkan pada proses berikutnya jika tidak maka selesai namun jika iya maka
admin dapat melakukan data validasi valins, setelah admin melakukan data validasi
valins admin melakukan proses decision untuk pengecekkan connectivity valid? Jika
tidak maka sistem akan meriksa sambungan dengan cara search data validasi jika iya
maka admin menyimpan database, selanjutnya sistem melakukan update database

validasi, dan proses bisnis nya selesai.
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Gambar 2. 4 Proses Bisnis Validasi Valins RFS



BAB Il
TAHAPAN KEGIATAN PRAKTIK MAGANG

A. LOKASI PRAKTIK MAGANG, ALAMAT, KONTAK
1. Lokasi dan Alamat Kerja Praktik.
Telkom Akses Yogyakarta, JI. MT. Haryono 21, Yogyakarta, DI Yogyakarta,

Indonesia.
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Gambar 3. 1 Lokasi Telkom Akses

2. Kontak
Kontak Pembimbing Kerja Praktik.
Nama : Faisal Fajri Rahani, S.SI.,M.Cs
NIY : 60191224
Kontak : 0878-2220-3029

Kontak Pembimbing Lapangan
Nama : Sekar Rini Abidin
Kontak : 0822-4306-6623

B. RENCANA OBSERVASI
Observasi dilakukan bertujuan mengetahui lokasi dan kondisi tempat kerja

praktik secara langsung. Rencana observasi meliputi :
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1. Nama Instansi : Telkom Akses Yogyakarta

2. Proses observasi : Mahasiswa yang melaksanakan magang datang ke instansi yang

dituju, selanjutnya memberikan proposal dan surat persetujuan magang dari
kampus yang sudah terlampir berapa lama magang nya, selanjutnya mengisi
google form yang telah disediakan pihak instansi melalui HR Telkom untuk kontrak
magang, selanjutnya mahasiswa datang ke Telkom Yogyakarta Kota Baru untuk
briefing, id card, dan tanda tangan kontrak magang beserta persyaratan magang
kepada mahasiswa, selanjutnya dialihkan ke instansi Telkom Pugeran untuk
magang di bagian Data Manajemen (DAMAN) dan menemui manager daman
sekaligus mahasiswa menyampaikan kontrak magang yang sudah disetujui oleh HR
Telkom Yogyakarta Kota Baru, setelah itu sistem kerja di daman yaitu work from
office jika mengerjakan project diperbolehkan untuk work from home, magang
tersebut dilaksanakan selama 3 bulan.

Hasil Observasi : Awal magang saya yang pertama hanya 1 bulan di tanggal 1
November — 1 Desember 2021, lalu extend 2 bulan pada tanggal 10 Oktober — 16
Desember 2022. Jadi magang dilaksanakan selama 3 bulan dimana sistem magang
dilakukan secara online offline dan setiap 1 minggu dua kali mahasiswa
menyampaikan progress yang sudah dikerjakan berdasarkan tugas masing-

masing.

C. RANCANGAN JADWAL KEGIATAN MAGANG

Tabel 3.1 adalah rancangan jadwal kegiatan KP Magang dibagi menjadi

beberapa tahap, tahapan-tahapan.

Tabel 3. 1 Rancangan Jadwal Kegiatan Magang dan Extend

Minggu Pelaksanaan (1 Nov — 1 Des Realisasi
No. Nama Kegiatan 2021)
November Desember Ya/Tidak %
112 |3 |4 |5 |1 |2 |3

1. Pengenalan instansi dan Ya 100%
pengambilan id card.

2. Menginput data RFS Ya 100%
menggunakan UIM

3. Delete Custome Involvements Ya 100%
(C1)

4. List Omset ODP Ya 100%

5. Menginputkan data RFS Ya 100%
menggunakan UIM
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Minggu Pelaksanaan (10 Okt — 16 Des 2022) Realisasi
No. Nama Kegiatan Oktober November Desember Ya/Tidak %
314 (112 |3(4]|5]|1 2 3
1. Pengenalan instansi dan Ya 100%
pengambilan id card.
2. Data Studio Cuti HD Daman Ya 100%
3. Cek dan update data QR DC Ya 100%
di Dava
4, Ukur masal ibooster Ya 100%
5. Penelusuran data port OLT Ya 100%
6. Switch to project by ask Ya 100%
7. Develop project (data Ya 100%
dummy)
8. Mirrorring project (data Ya 100%
real)
9. Testing dan Revisi Ya 100%
10. | Dokumentasi project Ya 100%
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BAB IV
HASIL PELAKSANAAN PRAKTIK MAGANG

A. HASIL OBSERVASI MAGANG

1. PROSES BISNIS

a.

Proses Bisnis Input Data Request for Service (RFS) Validasi Valins Menggunakan
Oracle Communications Unified Inventory Managament (UIM).

Dapat dilihat pada Gambar 2. 4 Proses Bisnis Validasi Valins di dalam
proses bisnis ini saya berperan sebagai admin. UIM merupakan solusi yang
digunakan untuk mengelola inventarisasi perangkat dan jaringan
telekomunikasi. Dalam proses bisnis ini, UIM digunakan untuk mengambil data
dari sistem RFS dan mengolahnya menjadi informasi yang dapat digunakan
untuk perencanaan, pengelolaan, dan pengoptimalan jaringan. Proses ini
meliputi langkah-langkah seperti pembersihan data, pengkategorian, dan
penyimpanan data yang diolah dalam sistem UIM. UIM juga dapat digunakan
untuk melakukan analisis data RFS dan menghasilkan laporan yang dapat
digunakan oleh manajemen untuk membuat keputusan yang tepat dalam
pengelolaan jaringan.

Proses Bisnis Mirrorring data Bot Telegram.

Dapat dilihat pada Gambar 2. 3 Proses Bisnis Mirroring, di dalam proses
bisnis ini saya berperan sebagai admin mirroring. Dalam proses bisnis ini
dilakukan untuk menggabungkan file Optical Distribution Cabinet (ODC) yang
disatukan menjadi file mirroring Security Token Offerings (STO), yang nantinya
STO (nama folder per daerah) tersebut dipanggil dalam pembuatan Bot

Telegram. Proses bisnis ini berfungsi.

2. RINCIAN PEKERJAAN

Ada beberapa kegiatan selama magang di Telkom Akses Yogyakarta adalah

sebagai berikut :

a.

Input Data RFS Validasi Valins Menggunakan Oracle Communications Unified

Inventory Managament (UIM).
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Untuk penginputan ini data diperoleh teknisi kemudian akan dilakukan
penginputan menggunakan UIM untuk menyamakan apakah data pada UIM
sudah lengkap atau tidak, jika data pada UIM tidak lengkap maka dilakukan
update pada sistem UIM. Penginputan data RFS menggunakan UIM bertujuan

untuk mempermudah manager DAMAN dalam mencari data yang akurat.

RFS DATA YANG SESUAI PADA SHEET.

e Buka sheet “Monitoring Order Daman” lalu pilih “RFS VALIDASI VALINS”. Copy

Online at untuk dikerjakan di UIM.

@ 0ywhats x | B8 LaporanPe X HE MONITOR: X & Services
(= C & docs.google.com
MONITORING ORDER DAMAN & o ~ o= X
! B
- @ 0N - R 5 00 123« Catirl - w - BISA %M T Evieldew BEY-z

L Type here to search 5 ® m @

Gambar 4. 1 Sheet Monitoring Order Daman

e Kemudian masuk pada /ink dan login menggunakan akun yang telah diberikan
pembimbing lapangan. Pada tampilan awal > klik services > paste nomor tadi
di kolom name kemudian piliih contains (tambahkan 0 didepan jika angka

depannya 2) > kemudian search.
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Gambar 4. 2 Tampilan Untuk Mencari RFS

e Lalu di Search Result klik ID dan Name nya harus ada RFS, kecuali RFS tidak
dikerjakan. Panah merah pada gambar adalah RFS, nomor pelanggan
0274488106 mempunyai layanan voice. *Kerjakan yang status nya in service

atau suspended, selain dari itu tidak dikerjakan*

F Laporan x # Monme x O Services X S S x © UMH

@ nossf-uim.telkom.co.id

£ Communications Unified Inventory Management Help ¥ Logout SNK17091992 O
Service
§ v Search
ivities
roup Activities Saved Search [ Service Search ~ |
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ess [nteractions _— —_—
ieering Work Orders v Status v
as Starts With v Party Name | Starts With v
irvice Orchestration
m Search | Reset | Saye. Add Fields  ~
sstration Requests
ork
FEEE  Search Results
Views | [§create /7 Ed Delete @ Epot | B | EfiDetach
ork Service Descriptors 4
Jescripte
e Name Description Specification Status Status Date # of Party
46316746 21595985_0274488106_VOICE_RFS Voice_RFS service created b... Voice RFS In Service 5/22/2016 1
46316736 21595085_0274488106_VOICE 21595985-1 |READINESS: ER. Volce_CFS In Service 5/22/2016 1
»
Total Resuits:

rtoryUiShell#

ype here to searc|

Gambar 4. 3 Tampilan Setelah Ditemukan RFS

e Lalu di Configurations klik version pilih versi yang paling atas atau yang terakhir

diedit, contoh version 5 > klik nomer nya.
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v Parties
View v [ Associate =
D Name Party Role

Total Results

901 AM E
12/1/2021 2

Gambar 4. 4 Tampilan Configuration RFS

e Lalu expand di bagian Subscriber_Terminal _Port dan di Service_Port

x B monme x O Service ! X o Service > 2 UM H

. telkom.co.id

cations Unified Inventory Management Help > Logout SNK17091992 O
Current ~

Service Configuration-46316746 - 21595985_0274488106_VOICE_RFS - Version5 3 Related Pages - Actions ~

~ Service Configuration Information

505085_0274488106_VOICE_RFS

on
~ Configuration Items
View v Format = | Bff Detach
a Resource Specification Assignment/Reference Status |Resource Actions
s 1 v g 215 0274488106_VOICE_RFS - 5-5- St

9:03 AM

12/1/2021

Gambar 4. 5 Tampilan Configuration Items

e Setelah di expend, sesuaikan pada sheet yaitu IP OLT, Port, Nama ODP, Port
ODP dan Service Trail (jika Port ODP nya sudah sesuai pada data sheet maka

service trail juga sesuai, jika sebaliknya maka harus dicari secara manual).
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— Pada kolom assignment/status : referenced berarti terisi, dan unreferenced
berarti kosong/tidak terisi.

— STP Tidak sesuai : Apabila nama ODP dan port nya tidak sesuai dengan data
validasi, maka perlu diperlu diluruskan.

— Service_Port : Port/OLT tidak sesuai dengan data validasi.

— Service_Trail : Diganti dengan yang baru apabila STP diganti

X £ MoNITC x O Service' X £ Service r Service Xeo © UIMH

m.telkom.co.id

ications Unified Inventory Management Help > Logout SNK17091992 O
Current ~

Service C ion-46316746 - 21 _0274488106_VOICE_RFS - Version5 3 Related Pages - Actions ~

v Service Configuration Information

4 8: 144881 RES
ted
tion
v Configuration Items
View ~ Format » | [ff Deta
Assignment/Ref¢

4 Configuration Resource Specification |Status |Resource Actio

9:05 AM
12/1/2021

Gambar 4. 6 Tampilan Configuration Items Complete

Data di sheet.

1 STo = IPOT = Slet = Port = ONUID = ONU'SN = Nama ODP = QR-Code ODP = PortODP = QR-CodeDropcore =  Offlineat = Onlineat =
85000 KBU | 172.29.236.217 6 12 19 48575443C618AAIC ODP-BBS-FG/051 TVTOSCGORF98 6 TVTOKIX68COF 274488106

Gambar 4. 7 Data Sheet

e Apabila sudah terisi langkah selanjutnya adalah klik Actions di pojok kiri >

aprrove > issue > complete.
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X F monn S Service Exec © UMHo X —

telkom.co.id
ications Unified Inventory Management Help v Logout SNK17091992 O
Current ~
Service Configuration-46316746 - 21595985_0274488106_VOICE_RFS - Version6 3 Related Pages - [RCtione
v Service Configuration Information Auto Configure

Approve
Cancel

v Configuration Items
View » Format~ | | Deta
Assignment/Ref

ors 4 Configuration Resource Specification Status |Resource

0914222

921 AM
12/1/2021

Gambar 4. 8 Setelah Dilakukan Pengeditan RFS

e Kemudian status pengerjaan diisi DONE.

PIC = Status Pengerjaan = Tel Progress
PRADANA DONE 1/12/2021
PRADANA PENDING 1/12/2021
PRADANA DONE 1/12/2021
PRADANA DONE 1/12/2021
PRADANA DONE 1/12/2021
PRADANA DONE 1/12/2021
PRADANA | DONE l 1/12/2021
PRADA 1/12/2021
PRADANA 1/12/2021

Gambar 4. 9 Melakukan Update Progres Pada Data Sheet

e Setelah itu di Current pada bagian atas angka pada bagian tengah di copy,

untuk mencari apakah ada RFS lagi atau tidak.
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@ oawh x | {8 Laporan X | §f MONITC X © Semvice! X 8 UMH
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ORACLE" Communications Unified Inventory Management H
~| Tasks Current ~
7 My Tasks Service Configuration-46316746 - FEL1 1111 0274488106_VOICE_RFS - Version5 3 F
My Actvities
+ My Group Activities ~|Service Configuration Information
(= sion 5 Previous Configuration 4
« Business Interactions o 463 8/a:
46316746_5 = e 8/4/20
« Engineering Work Orders k:,,,f, o . - - e B/4/202
o s 21595085_0274488106_VOICE_RFS - 5 e
Completed ce 46316746 - 21595085 027448
s = Specification Access_RFS_Configuration Associated To Busines:
~| Network Service Orchestration [
/ Orchestration
« Orchestration Requests ~|Configuration Items
* Network Services
+ VNFs View  Format ~ | [ Detach
7 Catalog Assignment/Ref
« Network Service Descriptors 4J Configuration Resource Specification Status Resource
* VNF Descriptors 7 g Service 85_0274488106_VOICE_RFS - 5 5 - S
v/ Services Senvice_Address Referenced 51491524 - SOLO 174 CATURTUNGGAL DEPOK SLE
o ODP_Panel_Downlink_Port  Referenced  361398405-695841208 - ODP-BBS-FG/0S1 FG/DOS,
FTTX_0DP Referenced 361398403 - ODP-BBS-FG/51 FG/DOS/051.01
GPON Referenced  160203356-639914222 - GPON_OLT:12

Huawei MAS600T Referenced 19875093 - GPON24-D4-KBU-2(172.29.236.217)

o=a Service_Trail Fiber_Customer TrallCircuit Assigned 2682069872 - trailByUIMTools_0274488106_20210
B S-Vlan VLANResource Referenced 502 - ACCESS VLAN POOL#502
¥ Liser Account Viear_Arroiint Assinnad 1077472414 - (117448841

28 P Type here to search

Gambar 4. 10 Tampilan Curent Untuk Mengecek RFS Kembali

e Cara mencari nya sama seperti yang diatas yaitu klik services > paste nomor
tadi di kolom name > kemudian search, dan dapat dilihat di Service Result
layanan voice RFS sudah dikerjakan dan pada bagian internet tidak termasuk
RFS karena status nya Disconnected, maka sudah tidak ada lagi RFS yang harus

dikerjakan.

x | §8 monn

O Service ! X

im_telkom.co.id

vications Unified Inventory Management Help~ Logout SNK170¢
Service m
~/Search
s v v
~ ~
>
stion Place
Sean Beset Saye. Add Fiel
~ Search Results
Vieww | [Roeate Hooot | B | Hipeac
Hors 4

Status Status Date 2ofPe

Gambar 4. 11 Hasil Curent Setelah Mengecek RFS
RFS DATA YANG TIDAK SESUAI DI DATA SHEET.

e Buka sheet “Monitoring Order Daman” lalu pilih “RFS VALIDASI VALINS”. Copy
OLT RX LEVEL OLD untuk dikerjakan di UIM.
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® oywh x | {8 Laporan x  HF MONITC X B e X | @ Becute X @ UMHo X | +

(= C & docs.google.com

B MONITORING ORDER DAMAN & e . - L @"'6‘3\ =

File Edit View Insert Format Data Tools Extensions Help

B - 0 - Ap 0 00 123+ Calibrl - - B I & A $HIEY Evieldryr o AEF Y~ I
850 172202362
L Q o
WOU T St T Pt T ONUID T ONUSN = Nama ODP = GRCodeODP = PoriODP = QR-CodeDropsore =  Offfineat = Onlineat = OTRKLEVELOID = Duration =  Inel = HAMAPELANGGAN =
6 17229255252 4 2 | w TrEGCRSSETIS ODP-88S /125 TVTOMAEISK4G 5 Tutosscuouno  a74asssse T sansinieses
+ E  RFSVALDASIVALINS ~  Sheeti0S PELURUSANSTO +  GANTI & OMSET ODP CO GANTI LABE DATA OMSET ODP CO OMSETDC 2021 +  REKAP MANUAL UIMTOOLS y

L Type here to search

Gambar 4. 12 Sheet Monitoring Order Daman

e Kemudian masuk pada link dan login menggunakan akun yang telah diberikan
pembimbing lapangan. Pada tampilan awal > klik services > paste nomor tadi
di kolom name kemudian piliih contains (tambahkan O didepan jika angka

depannya 2) > kemudian search.

@ (a X | #¥ taporan x  HE MONITC X | @ Service X @ Service: X |8 Service: X = © Services X B Beate X @ UMHo X +

= & @ nossf-uim.telkom.co.id

ORACLE" Communications Unified Inventory Management Help~ |

Recent Items »  Favorites -

v| Tasks Service@ 2
7 My Tasks

. ~|Search
« My Activities
« My Group Activities Saved Sei
7 All Tasks

P ID | Starts With v Name | Starts With hd
« Business Interactions = s
« Engineering Work Orders Specification e Status v
* Projects Party Id | Starts With v Party Name | Starts With v

3 Place

| Network Service Orchestration
7 Orchestration
» Orchestration Requests

* Network Services
. VNF‘; " ~|Search Results

7 Catalog Viewv | [ create 7 edit pelete g eport | B | i petach
o Network Service Descriptors 1] 3

+ VNF Descriptors
& D Name Description Specification Status Status Dat
No data to display

Search Reset Sa

| Services

* Seivices

88 O Type here to search =} ® 30c ~ ®E m g

Gambar 4. 13 Tampilan Untuk Mencari RFS Data Tidak Sesuai Sheet
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e Lalu di Search Result klik ID dan Name nya harus ada RFS, kecuali RFS tidak
dikerjakan. Panah merah pada gambar adalah RFS, nomor pelanggan
141131119309 mempunyai layanan Internet. *Kerjakan yang status nya in

service atau suspended, selain dari itu tidak dikerjakan*

x F monme x O Service Service Service Service x O UIM Hc

im.telkom.co.id

rications Unified Inventory Management Help =~ Logout SNK17091992 O
Service®
~|Search
Saved Search [ Service Search ¥
ID [ Starts with v Name |G v] [1a1131119300
s Specification ~ ~
Party Id Starts With hdl
>
tion Place
BSsmhy| Beset | Sae. | AddFields ~
~|Search Results
Views | [§create it oot | B | Hipetach
tors uJ
D Name Description Specification Status Status Date 2 of Party

1385575408 21596604_141131119309_INTERNET Broadband_Internet_Access CFS In Service 5/28/2021 1

/‘]855.’5421 21596604_141131119309_INTERNET_... Broadband_Access_RFS serv... Broadband_Access_RFS In Service 5/28/2021 1

Total Results:

ntory/faces/InventoryUIShell#

10:20 AM

12/1/2021

Gambar 4. 14 Tampilan Setelah Ditemukan RFS Pada Data Tidak Sesuai Sheet

e Lalu angka pada panah biru pada bagian depan di copy 21596604, untuk

mencari apakah ada RFS lagi atau tidak.

v|Search Results

View « B Create 7 Edit % Delete [@ Export E\f ;j' Detach
D Name Description —55 | Specification Status
1385575408 \A 21596604_141131119309_INTERNET Broadband_Internet_Access_CFS In Service
1385575424 21596604_141131119309_INTERNET_RFS Broadband_Access_RFS serv... Broadband_Access_RFS In Service

Gambar 4. 15 ID Untuk Mencari RFS Kembali

e Cara mencari nya sama seperti yang diatas yaitu klik services > paste nomor
tadi di kolom name kemudian piliih contains > kemudian search. Pada panah
merah itu layanan internet yang tadi diatas, dan pada panah kuning yaitu ada
RFS baru yang harus dikerjakan nomor pelanggan 46313176 mempunyai

layanan voice.

*Maka memiliki dua layanan yaitu layanan internet dan layanan voice,

dikerjakan satu-satu*
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@ nossf-uim.telkom.co.id

RACLE" Communications Unified Inventory Management Help ~ Logout
Tasks Service s
e v/Search

+ My Activities
* My Group Activities

All Tasks
« Business Interactions
« Engineering Work Orders
+ Projects

Network Service Orchestration > Place

Orchestration S
+ Orchestration Requests 13

* Metwork Service:
we «/Search Results

Catalog View~ | [JCeate Hopot | B
+ Network Service Descriptors 4
 VNF Descriptors a

D Name Description Specification

Services

* Serviceg

Broadband_Access_RFS serv...

L Type here to search

Gambar 4. 16 Hasil Setelah Mencari RFS

e Pada layanan internet, di Configurations klik version pilih versi yang paling atas

atau yang terakhir diedit, contoh version 3 > klik nomer nya.

B Mor X © Sem X

telkom.co.id

cations Unified Inventory Management Help > Logout SNK17091992 O
Service Summary - 1385575424 - 21596604_141131119309_INTERNET_RFS 3 Related Pages - Actions -
v Service Information Edit

> Other System

~ Configurations

10:34 AM F
12/1/2021 1

Gambar 4. 17 Tampilan Configuration RFS

e Lalu expand di bagian Subscriber Terminal Port dan di Service_Port
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O Bxec X o umM X

1s Unified Inventory Management Help= Logout SNK17091992 O
Current ~

Service Configuration-1385575424 - 21596604_141131119309_INTERNET_RFS - Version3 3 Related Pages ~ Actions ~
| Service Configuration Information Edit

n 2

7/28/2021

Version 3 Previous Configura

ess_RFS service created by autodesign - 3 E

Status  Con 85575424 - 21596604_141131119309_INTERNET_RFS
Specification Access_RFS_Configuration Associated To Business 2347560733 - Modify Broadband_Internet_Access CFS 1385575408
Interaction

~|Configuration Items

View  Format = | ol Detact

Configuration Resource Specification Assignment/Reference Status | Resource Actions
4 'V g Service:Broadband_Access_RFS service created by autc

|- g Properties
& Jdress / Servica_Address
b g S _Terminal_Port ODP_Panel_Downlink_Port e ced
o0 Ses i Fiber_CustomerTrailCircuit Assigned
- &8 CPE DHN_F609 12

15-639323766 - Port-2
ACCESS VLAN POOL #2406
3936030320 - 141131119309

- g Service_Por GPON
=3 S-Vlan VLANResource
> [ User_Account User_Account

Gambar 4. 18 Tampilan Configuration Items

e Setelah di expend, sesuaikan pada sheet yaitu IP OLT, Port, Nama ODP, Port
ODP dan Service Trail (jika Port ODP nya sudah sesuai pada data sheet maka
service trail juga sesuai, jika sebaliknya maka harus dicari secara manual).

— Pada kolom assignment/status : referenced berarti terisi, dan unreferenced
berarti kosong/tidak terisi.

— STP Tidak sesuai : Apabila nama ODP dan port nya tidak sesuai dengan data
validasi, maka perlu diperlu diluruskan.

— Service_Port : Port/OLT tidak sesuai dengan data validasi.

— Service_Trail : Diganti dengan yang baru apabila STP diganti.

Gambar dibawah ini hanya STP (Subscriber_Terminal _Port) saja yang tidak sesuai

karena Port ODP nya tidak sama seperti data di sheet.
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(149 x | §8 Lapc X {E MO X O Servi Servi X Serv 5 b X | 8 umM

C @ nossf-uimtelkom.co.id,

PACLE Communications Unified Inventory Management Help > Logout SNK17091992 O
1sks Current ~
v Tasks Service Configuration-1385575424 - 21596604_141131119309_INTERNET_RFS - Version3 3 Related Pages - Actions ~
o My Activities
+ My Group Activities ~ Service Configuration Information Edit
I Tasks version 3 2
+ Business Interactions ID Se_1385575424_3 7/28/2021
. Work € . -
0 rders Name Broadband_Access_RFS service created by autodesign - 3 at
Status Completed Service 1385575424 - 21506604_141131110300_INTERNET_RFS
Specification Access_RFS_Configuration Associated To Business 2347560733 - Modify Broadband_Int
stwork Service Orchestration e e T Pteractio
rchestration
« Orchestration Requests | Configuration Items
« Network Sarvices N
* VUNFs View v Format~ | [} Detach
atalog Assignment/Referen
+ Network Service Descriptors * G Resource Specification Status Resource Action:

« VNF Descriptors v g Service:Broadband_Access_RFS service cre:

srvices Service_Address Referenced

AN

« Services Referenced - ODP-BBS-FN/125 FN/D07/125.01-PANELO1-3
Referenced
Assigned

Referenced

Referenced 8315-639323766 - Port-2

ZTE 7XA10 €300 Logical D... Referer

I ANRocrusrra Rafor

2 - GPOND2-D4-BBS-3(172.29.236.252)
574 - ACCESS U1 AN DO 2

0

10:37 AM
12/1/2021

O Type here to search

Gambar 4. 19 STP Tidak Sesuai Pada Data Sheet

Data sheet

IPOT =  slet = Pot = ONUID = ONU SN = Nama 0DP = QR-CodeODP = PortODP = QR-CodeDropcore = Offineat = Onlineat = OLTRXLEVELOLD *
85016 | 172.29.236.252 4 2 12 ZTEGC8E56778 ODP-BBS-FN/125 TVIOMAEIGKAG 6 TVT038GVOUHO 274489556 141131119309

Gambar 4. 20 Data Sheet

e Klik Actions > klik Create New Version > Save and close.

B MOor X © Sevi X B Sevi X B Sevi X B Sevi X B Bxec X B UM X

.telkom.co.id

ications Unified Inventory Management Help + ut SNK17091992 O
Current ~
Service Configuration-1385575424 - 21596604_141131119309_INTERNET_RFS - Version3 3 Related Pages - [NEHORE

¥ Service Configuration Information

Create New Version

x

Previous G

1385575424 - 21596604

Spe ssoclats 23475 Modify Br
ion
~ Configuration Items
View » Format~ | fff Deta
Assignment/Referen
os d Configuration Resource Specification Status Resource Action:

7 g Service

Gambar 4. 21 Untuk Creat New Version RFS

e Apabila ingin mengubah STP maka klik Reference/ de-Reference > ubah

menjadi Specification ODP Panel Downlink > Reference.
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B mor x O Servi X O Servi > Serv erv Xec 2 uMm x

. telkom.co.id

ications Unified Inventory Management Help v Logout SNK17091992 O
Current ~
Service Configuration-1385575424 - 21596604_141131119309_INTERNET_RFS - Version4 3 Related Pages - Actions ~
~ Service Configuration Information Edit
Version 4 Previous Configuration 3

Start Date  12/1/2021
9_INTERNET_RFS - 4 te

ce 1385575424 - 21596604_141131119309_INTERNET_RFS

1 Access_RFS_Configuration

ion
~ Configuration Items
View » Format » | [off Detach
Assignment/Refg
ors 4 Configuration Resource Specification Status Resource Actions

ice_Address

ubscriber_Terminal_Port 361296350-695393678 - ODP-BBS-FN/125 FN/D07/125.01-PANELD1-3
&R Target 361296336 - ODP-BBS-FN/125 FN/DO07/125.01
-0 Service_Trail 2505864757 - trailByUIMTools_0274489556_141131110309_20210702  Unassign
- @R CPE De-Re
7 g Service_Port Referenced 2 De-Reference
stics

E- [ Char
rget ZTE 2XA10 C300

\A ANRes

ogical Device Ref

q 10:44 AM
1 2021
Nﬁignment/Ref1 |
Configuration Resource Specification Status Resource Actions
V g Service:21506604_141131119309_IN
- g Properties
i Service_Address Service_Address ‘ Referenced 1253817947 De—Refelguce
7 2 g Subscriber_Terminal_Port Pending Unrefer 361296350-695393678 - ODP-BBS-FN/125 FN/D07/125.01-PANEL01-3 ggge‘:eme
&3 Target FTTX_ODP Referenced 361296336 - ODP-BBS-FN/125 FN/D07/125.01 De-Reference
o—a Service_Trail Fiber_CustomerTrailCircuit Assigned 2595864757 - trailByUIMTools_0274489556_141131119309_20210702 Unassign
- &3 CPE ZXHN_F609 Referenced 405765512 De-Reference
7 &g Service_Port GPON Referenced 159378315-639323766 - Port-2 De-Reference
L [{ig Characteristics
Target ZTE ZXA10 €300 Logical Device Referenced 116625162 - GPON02-D4-BBS-3(172.29.236.252) De-Reference

Gambar 4. 22 Mengubah STP Pada Configuration Items

e Lalu copy sheet pada bagian Nama_ODP > paste ke Port Name > kemudian

search.
Port Search
nce Physical Port to C ion (@)
rch
Port ID | Starts With hd Port Name | Starts With V| | ODP-BBS-FN/125

Specification Inventory Status v

Assignment Status Condition Type b
Role Port Nurmber

ADER_PORT_NAME | Starts With v Customer Port Name | Starts With v

Equipment ID | Starts With v Equipment Name | Starts With N
sment Specification Physical Device ID | Starts With v
ysical Device Name | Starts With v Physical Device Specification

»
/M Resat Add Fields..

Gambar 4. 23 Seacrh Nama ODP Pada Port Search

e Kemudian pilih Port_ODP nya 6 karena menyesuaikan pada data sheet > lalu

OK.
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« My Group Activiti
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= Business Interact
« Enginesring Work
« Projects
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sork Service Orcl

estration

» Orchestration Ret
= Network Services
* VNFs

log

= Network Service |

Reset Add Fields...

= VNF Descriptors v Search Results l
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TTED1-24

Services

3 ]
Total Results

Gambar 4. 24 Hasil Search Nama ODP

e Mengubah Service Trail. Karena STP nya tidak sesuai pada data sheet, pada
bagian service_trail juga ikut tidak sesuai. Maka dari itu harus diubah dan

disesuaikan seperti data sheet. Copy ID pada Port_ODP 6 > paste ke notepad

dan save.
361296350-695393678 ODP-BBS-FN/125 FN/D07/125.01-PANELO1-3 QDP_Panel_Downlink_Port 3
361296350-695393679 ODP-BBS-FN/125 FN/D07/125.01-PANELO1-4 ODP_Panel_Downlink_Port 4
361296350-695393680 / ODP-BBS-FIN/125 FN/D07/125.01-PANELO1-5 ODP_Panel_Downlink_Port 5
361296350-695393681 ODP-BBS-FN/125 FN/D07/125.01-PANELO1-6 ODP_Panel_Downlink_Port 6
361296350-605393682 ODP-BBS-FN/125 FN/D07/125.01-PANELO1-7 QODP_Panel_Downlink_Port 7
361296350-695393683 ODP-BBS-FN/125 FN/D07/125.01-PANELO1-8 QODP_Panel_Downlink_Port 8

| serive trail untuk inet - Notepad

File Edit Format View Help

PORT_ID,TRAIL_NAME,BIT_RATE
361296350-695393681, ,0

Gambar 4. 25 Service Trail Untuk Inet

e Pilih Excute Rule > pada Ruleset pilih CREATE_SERVICE_TRAIL_CIRCUIT >
masukkan file notepad yang tadi > kemudian process. Setelah itu akan muncul

Trail Pipe Created with ID.
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A

Execute Rule® Process
~| Services

| Execute Rule Information \
0 S uleset: | CREATE_SERVICE_TRAIL_CIRCUIT v
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Gambar 4. 26 Mencari ID Trail Pipe Created

Execute Rule
Execute Rule Information

Processed 1 Records Successfully. \:;) Information

Trail Pipe Created with ID : 889546116

ok |,

Gambar 4. 27 Trail Pipe Created With ID

e Untuk mengubah service_trail terlebih dahulu copy Trail Pipe Created with ID

89546116. Klik Assign / Unassign > Specification tidak perlu diubah > Assign.

v|Configuration Items

View ~ Format ~ | g4 Detach
Assignment/| lhf1
1 Configuration Resource Specification Status Resource Actions
V g Service:21596604_141131119309_IN
L g Properties

J Service_Address Service_Address Referenced 1253817947 De-Reference
Vet e USRI i s 0O OSSN MDD s
B2 Target FTTX_CDP Referenced 361296336 - ODP-BBS-FN/125 FN/D07/125.01 De-Reference

0—a Service_Trail \ Pending Unassig 2595864757 - trailByUIMTools_0274489556_141131119309_20210702 ggﬂ
- & CPE ZXHN_F609 Referenced 405765512 De-Reference
WV g Service_Port GPON Referenced 159378315-639323766 - Port-2 De-Reference

=3 @ Characteristics

Gambar 4. 28 Mengubah Service Trail

e Masukan ID yang sudah di copy > kemudian search. Lalu di Search Result di klik

> kemudian OK.
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+ Search Results
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Gambar 4. 29 Search Trail Pipe Created with ID

e Apabila sudah terisi / sesuai maka langkah selanjutnya adalah klik Actions di

pojok kiri > aprrove > issue > complete.

x B monme x 5 x O Service 5 S UM H: x O Execute X +

im.telkom.co.id,

nications Unified Inventory Management Help» Logout SNK17091992 O
Current ~
Service Configuration-1385575424 - 21596604_141131119309_INTERNET_RFS - Versiond 3 Related Pages - [NEHORE
| Service Configuration Information Auto Configure
3 \A
12/1/201 Lot
s
o_INTERNET_RFS - 4 Cancel
Serice 1385575424 - 21506604_141 Vg
. 3 on Acc Associated To Bu
ation Inter
N \aligate
~ Configuration Items
View = Format | || Detach
Assignment/Refd |
ptors d  Configuration Resource Specification Status Resource Actions

v gF Service:21596604_141131119309_IN
I> g Properties

§ Service_Address De-Reference

Referenced

78 - ODP-BBS
81 - ODP-BBS-F

/125 FN/DD7/125.01-PANELO1-3
25 FN/DO07/125.01-PANELO1-6
125.01 De-Reference

7 3. Subscriber_Terminal_Port De-Reference

&R Target

Referenced

a—a Service Trail rerTralCrait Pending U 0274489556_141131119309 2010702 o
L~ & CPE 2XHN_F609 Ref 512 De-Reference
7 g Service_Port GPON Referenced 315-639323766 - Port-2 De-Reference
& fi Ch stics
T TTE FYAIN 300 | nnieal Rndrn Defrrmnend 11RAISIAT - AROMNINABES_ 177 W 774 787 P D rbrrmnen -

11:06 AM

12712021

Gambar 4. 30 Proses Setelah Melakukan Pengeditan RFS

e Layanan internet sudah berhasil di ubah, setelah itu layanan voice juga diubah
dengan langkah-langlah nya sama seperti mengubah layanan internet hingga

complete.
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b. Mirroring data Bot Telegram.

Mirroring database adalah proses menyalin data dari satu database ke
database lain yang berjalan secara real-time atau near real-time. Ini digunakan
untuk meningkatkan ketersediaan dan keandalan data dengan memastikan
bahwa salinan cadangan dari data tersebut selalu tersedia jika terjadi
kegagalan sistem atau masalah lainnya. Metode yang digunakan untuk
mirroring database yaitu spreadsheet untuk melakukannya secara built-in.

Permasalahan pemanggilan data sebelum dilakukan proses mirroring
yaitu data ODC yang sangat banyak dan tidak bisa dikurangi yang berakibat
hanya 1 STO saja yang berhasil dalam pemanggilan data yaitu Babarsari (BBS),
maka dilakukanlah proses mirroring data ini untuk memudahkan pemanggilan
data dalam pembuatan bot telegram, untuk menjaga keamanan data, dan
memastikan bahwa data dapat dipulihkan jika terjadi masalah pada sumber
utama.

Dapat dilihat pada gambar 4. 31 berisi data mancore untuk project bot

telegram.

B laporanon X | B0 (TNla % X @ progres-F X | [@ Minoring T X | @ apaitumo X | @& TabBaru

Q. Telusuridi Drive = @& =@
Dibagikan kepada saya MANCORE ALL JOGJA = | O o)
Nama Pemilik Terakhir diubah Ukuran file
B 01. BABARSARI (BBS) Kar Rini Abidi 4 Jul 2022 Sekai

B3 02. KOTAGEDE (KGD) Sekar Rini Abidin 4 Jul 2022 Sekar Rini Abidin

03. BANTUL (BTL) Sekar Rini Abidin 4 Jul 2022 Sekar Rini Abidi

B3 04. GODEAN (GOD) Sekar Rini Abidi 4 Jul 2022 Sekar Rini Abidir

B 05 KALASAN (KLS) ekar Rini Abidi 4 Jul 2022 Sekar Rini Abid

B3 06. PAKEM (PKM) Sekar Rini Abidin 4 Jul 2022 Sekar Rini Abid

B 07. KENTUNGAN (KEN) Sekar Rini Abi 4 Jul 2022 Sekat Rini Abidir

B8 08 KOTABARU (KBU) Sekar Rini Abidit 4 Jul 2022 Sek

09. PUGERAN (PGR) ekar Rini Abidi 4 Jul 2022 Sekar Rini Abid

B 10. SLEMAN (SMN) kar Rini At 4 Jul 2022 Sekar Rini Abid

B 11 WONOSARI (WNS) Sekar Rini Abid| 4 Jul 2022 Sekar Rini Abidir

12. WATES (WTS) ekar Rini Abidi 4 Jul 2022 Sekar Rini Abidir

9:49 AM

o ~ B
Q, search > ¢ @ 119/2023 ]

Gambar 4. 31 Mancore All YK
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Pada gambar 4. 32 merupakan STO Babarsari (BBS), untuk ODC yang
masih terpisah akan digabungkan ke file mirroring untuk mempermudah

dalam pemanggilan data di bot.

01. BABAR: X [ laporan o ® (77 X @ progres x @ Miroring! X | @ apaitumo X | & TabBaru

b.google.com,

Q Telusuri di Drive

i
®
o
®

[

Dibagikan kepada saya MANCORE ALL JOGJA 01. BABARSARI (BBS) a8 #m 0 B
Nama 1 Pemillk Terakhir diubah Ukuran file
E8 Mirrorring BBS 2% Access Daman YK 2 Des 2022 say, KB
(]
ODC-BBS-FAA 2% Sekar Rini Abidin Now 2022 Access Daman YK 28 KB
)
8 opcBBsFAC 2% Sekar Rini Abidis e say 1KB
£ ODC-BBS-FAD & Sekar Rini Abidis 6 Nov 2022 Sekar Rini Abidin 23 KB
+
ODC-BES-FAE 2% Sokar Rini Abidin 6 Nov 2022 Sakar Rini Abidin 24 KB
8 ODC-BBS-FAF 2u ess Daman YK 6 Nov cess Daman YK KB
8 ODCBBSFAH 2% Access Daman YK 4 Des 2022 Wulan 27KB
ODC-BBS-FAL 2t Access Daman YK Nov 2022 Access Daman YK 20 KB
ODC-BBS-FAM 22 Access Daman YK 6 N Access Daman YK 21 KB
@ oDCBBS-FAN it Access Daman YK Nov 2022 Access Daman YK 20 KB
ODC-BBS-FAP 2t Access Daman YK 6 Now 2022 Access Daman YK 22 KB
3 oDC-BBS-FAQ it ess Daman YK cess Daman YK 30 KB s

@ L 9:50 AM
Q search B o ™G v Gl o023 @

Gambar 4. 32 Mancore Babarsari (BBS)

Pada gambar 4. 33 merupakan mirroring BBS, untuk rumus yang
digunakan dapat dilihat pada panah di gambar, rumus nya berisi link “ODC-

BBC-FA” pada sheet “mancore update” dan diberi jarak batasnya hingga 505.

Rumus nya berlaku pada seluruh mirroring STO mancore.

% 01.848 X B Mimomi X ® 77 » < apaitur X ab Baru + [=

& docsgoogle.com

Mirrorring BBS # & &

% = ]
= o 2

File Edit Tampilan Sisipkan Format Data Alat Ekstensi Bantuan erakt 13 l E b
o)

o o ® P W v £ % 0 09 123w W - BISA &B SE-i-Ppl-w- B@EY~-z-

BS - =IMPORTRANGE( "https: //docs. google. com/spreadsheets/d/1ExvFUTbgfr 1 cORPTEFHLGyyC2zSMIE_EXSqpMXXrBAo/edi tigid=1686373713", "MANCORE UPDATE!BS:AG

our & oa FEEDER or
OLT NAMA OLTSLOT OLT PORT EARACK EAFTB EAPORT OARACK OAFTB OAPORT FEEDERNAMA  FEEDERKAP FEEDERCORE  ODCNAMA ODCPANELIN ODCPORTIN ODC SPUTTI @
ODC-BBC-FAA
GPONQO-D4-BBS-5 . 1 10 1 3 55 1 3 6 ODC-BBS-FAA 1 1 SPLLIAKEC "
GPONOO-D4-BBS-S 1 10 1 3 55 1 3 & ODC-BBS-FAA 1 1 SPLLAKEC -
GPONOG-DA-885-5 1 1 1 s s 1 3 s [IYFTEERN 1 1 sPLLAKEC
GPONOO-DA-885-5 1 10 1 s s L 3 . oDC-BES-FAA 1 1 ek g
GPONOO-Da-885-5 2 1 a s oDC-B8S-FAA sPLLAKEC
GPONOO-DA.885-5 2 1 a s opeBss-FAA seLLaKEC
GPONQO-D4-BBS-5 2 1 A 5 25 ODC-BBS-FAA SPLLAKEC
GPONOO-D4-BBS-5 2 1 A 5 5 ODC-BBS-FAA SPL1AKEC
GPONOO-D4-BBS-5 2 2 A 5 6 ODC-BBS-FAA. SPLLAKEC +
GPONDO-DA-BBS-S 2 2 A s % oDCBESFAA SPLIAKEC
GPONOG-DA-88S-S 2 2 A s 2 oocs-FAA sPLIAKEC
6PONOO-DA-885-5 2 2 a s 2 0DC-B8S-FAA SPLLAKEC
GPONOO-DA-8B5-5 3 s a s oDCBBS-FAA sPLLAKED
GPONO-DA-BBS-5 3 . a s oz opeBssFAA sPLLAKED
GPONOO-DA-8B5-5 3 s a s opeBEs FAA sPLLaKE
GPONOO-D4-BBS-5 3 e A 5 27 ODC-BBS-FAA. SPL1:AKE]
GPON0O-D4-BBS-5 a a 1 3 86 1 3 87 ODC-BBS-FAA. 5 13 SPLIMAKED
GPONDO-DA-885-5 1 4 1 s s 1 1w oDCBES-FAA s 13 sPLudkeD
+ = MANCORE UPDATE = >

Gambar 4. 33 Mirroring BBS
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B. PEMBAHASAN MAGANG
Penulis melakukan bebrapa pekerjaan lainnya yang dapat dilihat pada Tabel 1
Rencana dan Realisasi Kegiatan Praktik Magang, untuk 1 bulan pertama penulis
melakukan input data RFS, delete custome involements (Cl), list data omset ODP.
Selanjutnya untuk 2 bulan extend magang penulis melakukan pembuatan cuti HD
Daman menggunakan data studio, lalu cek dan update data QR DC di Dava, lalu
mengukur masal ibooster, melakukan penulusuran data port OLT, selanjutnya switch
to project by ask untuk project membuat bot telegram yang dimana penulis bertugas
untuk mirroting data nya, lalu develop project (data dummy), selanjutnya proses
mirroring project untuk data real nya, selanjutnya melakukan testing dan revisi, dan
terakhir dokumentasi project.
1. PROBLEM YANG DITEMUKAN SEBAGAI TOPIK PRAKTIK MAGANG
Minimum sumber daya manusia yang ada di bagian DAMAN dalam mengelola
RFS, sehingga memerlukan bantuan untuk melakukan input data RFS. Terdapat
kendala saat melakukan input data RFS yaitu pada saat data di RFS tidak sesuai
dengan data sheet maka harus menginputkan kembali semua nya sehingga sama
dengan data sheet.
Untuk mirroring bot terdapat kendala saat melakukannya yaitu jika jarak
batas nya tidak sesuai akan terjadi penumpukkan dan berakibat data nya eror di
sheet mirroring dan jumlah ODC per STO nya itu sangat banyak maka harus
diperhatikan sedetail mungkin untuk meminimalisir eror atau terlewat pada saat
mirroring. Permasalahan pemanggilan data sebelum dilakukan proses mirroring
yaitu data ODC yang sangat banyak dan tidak bisa dikurangi yang berakibat hanya
1 STO saja yang berhasil dalam pemanggilan data yaitu Babarsari (BBS).
2. ANALISA TERHADAP HASIL OBSERVASI
Pada tahap implementasi harus memahami dasar-dasar apa saja yang
dibutuhkan untuk input data RFS dan mirroring. Berdasarkan hasil dari observasi
magang telah mengetahui apa saja yang akan dibutuhkan, mulai dari proses bisnis
yang terjadi dan perangkat yang digunakan untuk melakukan input data RFS dan
mirroring. Dengan begitu dapat menyusun hasil observasi menjadi laporan yang

baik dan benar.
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3. CAPAIAN MAGANG

Evaluasi dan pemantauan magang dilakukan setiap 1 minggu sekali bersama
dengan pembimbing lapangan, sehingga kegiatan magang tetap terpantau oleh

pembimbing lapangan dan manager DAMAN.

vvvvv

Gambar 4. 34 Evaluasi Dengen Pembimbing Lapangan

Input data RFS menggunakan UIM, untuk target perhari > 50 untuk total input
data nya ada 602 data yang sudah complete. Dapat dilihat pada gambar 4. 35

pencapaian perhari nya.

c docs.google: 2 » w = O & H
E Laporan Pencapaian RFS  ¥r & & ST o
File Edit Tampilan Sisipkan Format Data Alat Ekstensi Bantuan
o~ @ P O00% - § % 0 00123 Defar(ai. ~ 10 - B I & A B S-i-PRl-%r 2 @MY I B
E133
8 ¢ 0 e F 6
1 HD Validasi Data (1) RFS Validasi Valins (2) Omset September / Validasi Dropcore (3) Validasi Dropcore Cek Ulang Manual (4) Bulk QR Code (5) Push None ODP Valins (6)
2 Target 10 60 100 50
Total 0 0 0 0 o @
24 November 2021 .
10 No Nama HD Validasi Data (1) RFS Validasi Valins (2) Omset September / Validasi Dropcore (3) Omset ODP CO (4) List Omset (7) Delete Cl (8) -
1 Pradana Eka Prameswarl 70
03 Total 0 70 0 0 0 ]
25 November 2021
No Nama HD Validasi Data (1) RFS Validasi Valins (2) Omset September / Validasi Dropcore (3) Omset ODP CO (4) List Omset (7) Delete CI (8) +
1 Pradana Eka Prameswari 20
2 septan owi Ranmanza |
109 Total 0 20 0 0 0 ]
10
m 26 November 2021
12 No Nama HD Validasi Data (1) RFS Validasi Valins (2) Omset September / Validas| Dropcore (3) ©Omset ODP GO (4) List Omset (7) Delete Gl (8)
13 1 Pradana Eka Prameswari 50
115 Total 0 60 0 [ 0 0
e =
+ = Depok - PKLUMY ~ PKLSMK1BANTUL ~ PKLUAD ~ @ PKLUPNG&ITTP ~ @ PKLSMKSewon - 4 Pelajari ’

Gambar 4. 35 Pencapaian Input RFS Menggunakan UIM
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Pada gambar 4. 36 dapat dilihat hasil mirroring bot telegram yang telah

dilakukan per STO.

Mirrorring BBS &%
Mirrorring KGD &%
Mirroring BTL <%

Mirroring GOD =%

Mirroring KLS &%

Mirrorring PKM &%
Mirrorring KEN &%
Mirrorring KBU <%
Mirrorring PGR =%
Mirrorring SMN =%
Mirrorring WNS &%
Mirrorring WTS &%

<

4. KEBERLANJUTAN

Kegiatan kerja praktik magang ini tidak berkelanjutan.

Gambar 4. 36 Hasil Mirroring
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BAB V
PENUTUP

. KESIMPULAN

Dari pengalaman penulis dalam parktik magang di Telkom Akses Yogyakarta
dapat disimpulkan sebagai berikut:

1. Validasi data menggunakan valins dapat mempermudah dalam melakukan validasi
RFS karena menggunakan valins dapat mempercepat waktu validasi data RFS.

2. Memudahkan untuk mengelola inventori jaringan dan memastikan bahwa data
RFS yang dimasukkan sesuai dengan standar yang ditentukan sehingga dapat
digunakan dengan benar dalam sistem lain. Ini memastikan bahwa data yang
diterima akurat dan dapat digunakan untuk proses bisnis yang tepat.

3. Mirroring data adalah proses penting untuk menjaga keamanan data dan
memastikan bahwa data dapat dipulihkan jika terjadi masalah pada sumber
utama. Namun, perlu diingat bahwa proses mirroring data harus dikonfigurasi dan
dijalankan dengan benar untuk memastikan bahwa data yang disalin akurat dan

up-to-date.

. SARAN

Saran dari penulis dalam praktik magang di Telkom Akses Yogyakarta, sebagai
berikut:

1. Pastikan untuk mengatur dan memantau proses validasi secara reguler untuk
memastikan bahwa data RFS yang diterima sesuai dengan standar yang
ditentukan.

2. Pastikan untuk memperbarui UIM secara berkala untuk memastikan
kompatibilitas dengan sistem lain yang digunakan dalam proses bisnis dan untuk
mendapatkan fitur terbaru yang dapat membantu dalam proses validasi data RFS.

3. Pastikan untuk mengkonfigurasi mirroring data sesuai dengan kebutuhan dan

jangan lupa untuk melakukan testing sebelum digunakan dalam proses produksi.
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